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Welcome to the 
ExcelsiorTM Appliance Service Plan

Congratulations on choosing to offer the ExcelsiorTM Appliance Service Plan to your clients. 

 

This program is designed to give clients buying a new appliance peace of mind, and at the same 

time, enable our retail partner to achieve the highest potential profitability through recommended 

complementary sales. 

 

As an authorized retail partner of our ExcelsiorTM Appliance Service Plan, this Administration Manual 

will outline the program and the procedures to follow when setting up and offering the program in  

your store. 
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Order Processing & Follow Up

B2B Service Re-Ordering

& Service Plan Registration Enquiries: 	 1-800-661-7313 Option 3

B2B Service Email:	 sales@phoenixamd.com

B2B Service Fax:	 1-905-427-4433			 

Accounting Telephone Enquiries:	 1-800-661-7313 x 237

Accounting Email 	 registration@phoenixamd.com 

Accounting Fax:	 1-905-427-2166

Service Plan Claims

B2C Service Telephone Enquiries & Claims:	 1-800-661-7313 Option 2

Claims Service Email:	 service@soswarranty.com

Register a claim on-line:	 www.phoenixamd.com/service.html

Mailing Address:	 Phoenix A.M.D. International Inc.

	 41 Butler Court, Bowmanville, Ontario L1C 4P8

B2C Claims Department Fax:	 1-905-248-3672

Quick Reference Contacts
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These price sheets contain the costing of the program along with the retail pricing to enter in your sales system, and is 

not for retail use. For post delivery pricing, please refer to the next page.

To download or view an updated copy of our program pricing, click on the link listed below.

Program Pricing for Appliance	

www.phoenixamd.com/appliance/APPL-35PL-19E.pdf

Program Pricing and SKU's
Pricing as of August 2019
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Program Pricing and SKU's
Pricing as of August 2019

These price sheets contain the costing of the program along with the retail pricing to enter in your sales system, and is 

not for retail use. For a retail price list card, please refer to the next page.

To download or view an updated copy of our program pricing, click on the link listed below.

Program Pricing for Appliance Post Delivery	

www.phoenixamd.com/appliance/APPL-35PDPL-19E.pdf
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Point of Purchase Material

To download or view a copy of our Point of Purchase Materials (P.O.P.), click on the links listed below. 

 Point of Purchase Materials: 
	

	       Brochure 

	  	

	       www.phoenixamd.com/appliance/APPL-35-BRO-01E.pdf

		

	

	      Don’t Use it, Don’t Lose it	  

	      Brochure Inserts		

	       

	      50% vs 100% Credit back: www.phoenixamd.com/appliance/19DUDL-01E.pdf 

	      

	      100% Credit back: www.phoenixamd.com/appliance/19DUDL-100-01E.pdf 

	     

	      Retail Price List Card(s)

	

	      Regular Pricing: www.phoenixamd.com/appliance/APPL-35RPLC-01E.pdf 

	      

	      Post Delivery:  www.phoenixamd.com/appliance/APPL-35RPLPD-01E.pdf

Placing Re-orders for P.O.P. Materials
There are 2 options for placing a re-order for any of the ExcelsiorTM Service Plan in-store Point of Purchase Materials. 

1. Electronic Order form 
Download a copy of the electronic order form by using the link below. Fill in your information and order, then click the 

Submit button inside the form to send your order to our B2B Service team.

Download Order form Link: www.phoenixamd.com/appliance/APPL35-REORDER-E.pdf

2. Contact Business to Business Service Team (B2B) at:

Phone: 1-800-661-7313 Option 3
Email: sales@phoenixamd.com
Fax: 905-427-4433 - Attention B2B Service
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Renewals are extensions of the original Service Plan, and terms and conditions remain the same.

Consumers looking to renew a Service Plan for their appliance must contact Phoenix A.M.D. International Inc. at

1-800-661-7313 Option 2 or email at service@soswarranty.com

Renewal Policy  

All ExcelsiorTM Appliance Service Plans are eligible for renewal, if certain conditions are met:

•	 The appliance must have at least 30 days remaining on the original ExcelsiorTM Service Plan 

•	 The appliance is for residential use only

•	 Renewals can be purchased for only one (1) year at a time, up to a maximum of seven (7) years from  

	 the original delivery date of the appliance

If a multiple appliance purchase was made, renewal Service Plans must be purchased and registered individually for 

each appliance. The renewal is an extension of the Original Service Plan, and terms and conditions remain the same.

Renewal Process  

•	Contact Customer Service at 1-800-661-7313 Option 2 or by email at service@soswarranty.com to verify 

	 the consumer’s eligibility

•	 If submitting a request by email, include the consumer’s name, phone number, delivery date 

	 as well as the invoice number

•	For further details and pricing, contact the B2B Customer Service Department at 1-800-661-7313 option 3 or by email  

	 at sales@phoenixamd.com

Renewals 
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How Post Delivery Pricing works

At the time of purchase, and for a period of 30 days after delivery, if your customer chooses to purchase an ExcelsiorTM 

Service Plan, regular pricing for the Service Plan would apply. After the appliance is delivered to the customer’s home, 

and the 30 day grace period has elapsed, an ExcelsiorTM Service Plan can still be purchased, but at Post-Delivery pricing.

Purchasing an ExcelsiorTM Service Plan after delivery, must meet the following criteria:

•	 Service Plan must be purchased within 11 months of the appliance being delivered

•	 The appliance(s) must still be covered for a minimum of 30 days under the Manufacturer’s Warranty Period

•	 The appliance is for residential use only 

When registering a post delivery Service Plan, enter the date of delivery of the appliance(s), not the date of the 

purchased Service Plan. All Service Plan Terms and Conditions, as well as coverages remain the same and become 

effective from the date of delivery. 

Late Registration Policy 

All Service Plans must be registered on the ExcelsiorTM registration website, excelsiorprotection.com, within  

45 days from the date of delivery. 

Service Plans registered 45 days after the date of delivery, will be charged Post Delivery pricing. 
Regular Service Plan pricing will no longer be valid. 

If a Service Plan is not registered by a retailer, and a claim is submitted by a consumer, the following steps will be put 

into effect by SOS Warranty Services Inc.:

1.	 Request a copy of the consumers invoice

2.	 Advise the Retail Partner they will be responsible for paying for the first claim 

3.	 Inform the Retail Partner that the Post Delivery pricing will be charged for the Service Plan, in order for  

	 SOS Warranty Services Inc. to cover the remainder of the Service Plan term

The Service Plan must be sold within the 11th month of the manufacturer’s warranty period. If exceeded  
the 11 month period, claims and registration will be declined. 

Post Delivery & Late Registration Policy 
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The Service Plans you enter on the website will be invoiced several times during the month. 

Invoices will be generated on the 1st, 8th, 15th, 22nd & 29th, as well as the last day of the month.

It is important to register your Service Plans on a timely basis to ensure proper invoicing and registration. Service 

Plans not registered within 45 days of their delivery date may cause delays in servicing a customer’s claim and will be 

subject to a 15% late registration fee.

For any questions you may have concerning your invoices, please contact our B2B Customer Service Department at 

1-800-661-7313 Option 3 or at registration@phoenixamd.com  

Invoicing and Registration
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Option 1 – Monthly registration through an e-file transfer
 

E-files are generated by your instore software. The software produces a file of all Excelsior Service Plans sold, and 

collects the data in a format that can be sent to Phoenix A.M.D. International Inc. for registration.

Requirements

A comma-delimited file (.CSV or .DAT) format is required to be exported from the sales software used in-store 

or head office. Click on the “CSV or DAT” link above to view an example.  

The retailer creates a report on the first day of each month for deliveries made the previous month and emailed  

to registration@phoenixamd.com. Monthly registrations must be received by the 5th of the month. 

Should you be interested in using this process, contact 1-800-661-7313 Ext. 333. Your software provider will require 

your authorization for Phoenix A.M.D. International Inc. to discuss the implementation, on your behalf, with them directly.

Option 2 – Register Service Plans online at excelsiorprotection.com

To register your on-line profile, follow the steps below to create an account on the excelsiorprotection.com website.

There are 3 easy ways to set up your registration account profile  

1. Register an account on excelsiorprotection.com (see pg. 10 for step by step instructions)

2. Call the B2B Service team directly at 1-800-661-7313 Option 3

3. Email sales@phoenixamd.com

Once the account is set up, you will receive a confirmation by email; your account may take up to 24 hours to 

become active

Service Plan Registration Options
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Once the program has been implemented in your store and you have been trained on how to sell the program, you will 

receive your Phoenix Division Number and Account Number from our B2B Customer Service Department. With this 

information, you can set up your on-line registration profile.

Below is a short outline of the process to set up your store for on-line registrations and how the program will work 

in your store

•	 Set up your login credentials. Within 24 hours, you will receive an email confirming your username & 

password for the online registration site

•	 Using the login credentials, you will log in to a registration session

•	 Register Service Plans sold

•	 Make corrections to the Service Plans entered if required

•	 We will invoice the Service Plans registered

•	 You can request corrections to Service Plans that have already been invoiced 

The following pages will describe each of the above steps and features in detail.

On-line Account Set Up & Registration
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Before you can start using the Excelsior Service Plan on-line registration module, you will need to register your store and 

get a username and password. To do so, follow the simple steps below.

1.	Enter the site www.excelsiorprotection.com.  At the login screen, click on New Registration

2.	Enter the information requested on the Sign-up sheet. All items with an asterisks (*) are mandatory fields  

	 Click Submit when completed

On-line Profile Set Up
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3. You will see a pop-up window that informs you that you will receive your username and password within 24 hours

Check your email account for your “Phoenix A.M.D International Inc. Confirmation” message containing your 

username and password. (If not found in your email, please check your junk mail folder) 

Your account may take up to 24 hours to become active

Note: If you wish to change the password you are given, send us an email with your request and the password you wish 

to have to registration@phoenixamd.com. We will change the password for you and provide you with a confirmation 

by email.

Write your username and password below for future reference.

Username: _________________________	Password: ____________________________

On-line Profile Set Up (Cont’d)
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Once you have received your username/password combination, you can log-on to the site to begin registering the 

Service Plans you have sold.

Go to excelsiorprotection.com and enter your username and password.

Select Guardian Angel

Once logged on, you will be at the Add Warranties page. You can access the website as many times as needed to 

enter your registrations. You can enter your Service Plans on a daily or weekly basis.

You must enter invoices one at a time.

Follow these easy steps:

1.	In the top section, enter the invoice number, customer and sale information required

2.	Select the appropriate Item Category in the drop-down box. A grid will open where you can enter all the items on the  

	 invoice you are registering

3.	In the grid table, enter the Item, Manufacturer, Model Number and Retail value for each item that you enter in the list

4.	Once you have entered the retail values, you will see a Warranty Code drop-down menu appear. Use the drop-down  

	 list to select the appropriate Service Plan code for the invoice you are registering

Registering Service Plans On-line
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 5.	 When you have completed the form, click Submit

		  Repeat the above steps for each Service Plan

After you enter a Service Plan, they are immediately available to be modified or removed. 

Our invoice cycles occur every 7 days and on the last day of the month.

Modifications or deletions can be made up until 11:59 PM Eastern Standard Time on the 7th, 14th, 21st, 28th and the 

last day of the month.  

See the following section for instructions on making modifications or deletions before the end of the invoice cycle.

Please refer to your Retail Price List on page 5 for the SKU’s available and pricing.

Registering Service Plans On-line (Cont’d)
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All Service Plans you have entered within an invoice cycle (entered but not billed by Phoenix A.M.D. International Inc.), 

are saved under the Modify tab on the website. Click on Modify to see what you have entered and make corrections, if 

needed.

The Service Plans will stay in the Modify tab until the end of the weekly invoice cycle. As long as the Service Plans are 

in this list, you can make changes and even delete them from the list.

Modify an Item within a customer’s registration 

To modify or edit an item from a Service Plan before it has been invoiced, click on the Modify tab. 

Locate the invoice number you need to make a correction on and click on the Pencil icon. 

1.	 The invoice will open, displaying all the items that were entered

2.	 Make the necessary changes to the items or customer information

3.	 Double-check that the warranty code is correct, by selecting the drop-down menu and selecting the right code

4.	 Once all changes are made, click on Submit

Deleting an Item or a full customer registration

To Delete a Service Plan entered in error, before it has been invoiced, click on the Modify tab.

Locate the invoice number you need to delete and click on the X icon. 

1.	 You will be asked to confirm the deletion of the invoice

2.	 Click Delete to proceed or Cancel to leave the Service Plan in the list

Once a Service Plan has been invoiced (at the end of the invoice cycle) it will no longer be available to make corrections 

on in the Modify List.

Making On-line Corrections & Changes
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If you require to make a correction or cancellation of a Service Plan after it has been invoiced by Phoenix A.M.D. 

International Inc., you will need to go to the View Tab and submit a Dealer Request.

To submit a Dealer Request:
1.	 Go to the View tab

2.	 Select the month and year in which you registered the Service Plan

3.	 Locate the Service Plan from the list and click on the Change Request pencil icon

Requests for Modifications after Invoicing
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4.	 You will be prompted to select a change category and enter a description of the change 

	 Using the drop-down menu, select the Change Category to make your request :

a.	 Cancel Warranty – To cancel a complete invoice (the Service Plan on all items on the invoice  

	 will be cancelled)

b.	 Change Customer Information – Request corrections to Name, Address, Phone, Email Address

c.	 Change Invoice number – Request a correction to the invoice number

d.	 Correct Delivery Date – Request a change to the Delivery Date

e.	 Update Item Information – 

i.	 Request a change to the Item Description, Manufacturer, Model or Retail

ii.	 Request a correction of the Service Plan Code

iii.	 Request a removal of an item from the Service Plan

5.	 Enter a brief description of change and click Submit to edit the Service Plan or click Cancel to leave  

	 the Service Plan unchanged

6.	 You will then be able to make the adjustment within the category you selected. Once complete, click Submit

Change Delivery 

Date example: 

Requests for Modifications after Invoicing (Cont’d)
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Submitting a request does not mean that it will be implemented automatically.

All Dealer Requests are subject to review by Phoenix A.M.D. International Inc. before being approved or rejected. 

If approved, changes will be reflected on the registration site, which can take up to 48 hours. 

If the request requires a change in warranty code, the adjustment will appear on the next weekly invoice. 

If your request is rejected, you will be notified by email of the reason for rejection.

Note that if a service plan has a claim registered against it or if it has expired, the request for modification will be 

rejected.

Modification requests for Service Plans three (3) years or older must be submitted by email to sales@phoenixamd.com 

or call 1-800-661-7313 Option 3.

Requests for Modifications after Invoicing (Cont’d)
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Overheating breakage is caused by heat in conjunction with 

a flaw in the glass.

Characteristics of an overheating break are:

•	 Fracture patterns

•	 The damage will always appears in the cooking zone

•	 Most of the cracks will be within the same zone

•	 Not one obvious impact point

Thermal Breakage Examples on Ceramic Cooking 
Surfaces Covered by SOS Warranty Services Inc.
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Tension breakage 

Tension breakage can be caused by the cooktop not being flat, or the installation cutout being too small.  

It may also be caused by a combination of incorrect installation and heavy pots or pans being placed on the cooktop

Characteristics of tension breaks:

•	Usually a single crack

•	Crack is usually from corner to corner 

	 or edge to edge. 

Improper installation causing tension 
breakage is not covered by the Service Plan

Impact breakage 

Impact breakage is caused by dropping an object and striking the surface 

Characteristics of impact breaks:

•	There is always a specific impact point

•	Cracks spread outward from 

	 the impact point

Impact breakage is not covered by the 
Service Plan

Thermal Breakage Examples on Ceramic Cooking 
Surfaces NOT Covered by SOS Warranty Services Inc.
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Terms and Conditions 
ExcelsiorTM Appliance Service Experience
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Terms and Conditions (Cont’d)

APPL-35-TC-02E



25

Frequently Asked Questions 

Do I charge the consumer taxes on their Service Plan? 
Yes, all applicable sales taxes should be charged to the consumer on ExcelsiorTM Service Plans. 

What happens to the purchased Service Plan once the item is refunded or replaced, 
due to a claim?    
In the event that a claim is filed against a Service Plan, and the item has been replaced or refunded by SOS Warranty 

Services, all obligations are deemed to have been fulfilled, and the original Service Plan will be terminated. The consumer 

has the option to purchase a new Service Plan on the replaced item.

 

Once a claim is filed against a Service Plan and the item is repaired, the original Service Plan stays in effect for the 

remainder of the term, or until the item is either replaced or repaired, up to the original purchase price before taxes.

If an item is exchanged after a few months, will the Service Plan start date change?
The original item’s date of delivery is what is used as the start date of the Service Plan. The original date will 

remain in effect, even after the item has been exchanged. For example, if a customer makes the original purchase 

in October 2017, and the item is exchanged in January 2018 for an identical item, the Service Plan’s effective 

start date is still October 2017. If there is a change in manufacturer, model or price, SOS Warranty Services must 

be notified so that the Service Plan details can be updated. Contact 1-800-661-7313 Option 2 or by email at 

service@soswarranty.com (refer to step by step instructions on pg. 14)

Will the cost of the Service Plan be refunded if the item is returned?
If the item is returned within the original manufacturer’s one (1) year warranty period, and providing there have  

been no claims on the Service Plan purchased, the Service Plan is refunded. A Cancel Warranty request can 

be submitted at excelsiorprotection.com

Does the consumer need to keep their invoice in order to be eligible for service? 
Yes, the consumer may be required to provide the invoice whenever contacting SOS Warranty Services for information 

on their Service Plan or if filing a claim. The invoice number is their Service Plan number, which serves as their proof of 

coverage. The customers invoice will also provide relevant information about the item being serviced, and details on the 

manufacturer, which may expedite the time delay required to provide service. 

Is the Service Plan transferable? 
Yes, the Service Plan is transferable, at no cost, from consumer to consumer only. 

Contact SOS Warranty Services at 1-800-661-7313 Option 2 or by email at service@soswarranty.com. The  

original owner will need to provide a letter confirming the intent to transfer the Service Plan to the new owner, with  

the following details: date of transfer, name of new owner, address, phone number, and details of the article covered. 

The original owner will need to provide the new owner the original invoice. The new owner may be required to produce 

this two documents as proof of coverage in the event that they contact SOS Warranty Services, for information on their 

Service Plan or if filing a claim.
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Frequently Asked Questions 

Do I need to register my monthly registrations before I can order additional  
ExcelsiorTM Service Plan point of purchase materials? 
Yes, to be eligible to order additional materials, you must be in good standing with Phoenix A.M.D. International 

Inc. This means that you must make regular and consistent registrations each month, and their payments are up 

to date. If you are not current with registrations and/or payments, you will not be able to order additional point of 

purchase materials.

What do I give my customer if they purchase an ExcelsiorTM Service Plan? 
Once your customer has purchased an ExcelsiorTM Service Plan, it is recommended that you staple their invoice and a 

copy of the Terms and Conditions to the Service Plan brochure. It is important that the customer keep these documents 

together should they have a future need to contact SOS Warranty Service for information or filing a claim.

How does the customer’s purchased service plan get registered? 
You must register the purchased Service Plan at excelsiorprotection.com within 45 days from the date of

delivery to avoid a late registration fee.

How do I correct an error on my registration invoice? 
Your registration invoice lists all the Service Plans submitted on our registration website. If you notice an incorrect entry, 

you can submit a correction or cancellation request through excelsiorprotection.com (refer to step by step instructions 

on pg. 15)

Why are some Service Plans charged post-delivery pricing on my invoice?
All Service Plans must be registered on the ExcelsiorTM registration website, excelsiorprotection.com, within 45 days 

from the date of delivery. Service Plans registered 45 days after the date of delivery, will be charged a post-delivery fee.

How do I register a multi-item Service Plan that has multiple delivery dates?  
Use the earliest delivery date for multi-item Service Plans with different delivery dates. For example, if a customer 

purchases a stove and a fridge on one invoice, and the fridge is delivered on August 1, but the stove will be delivered on 

November 3, then August 1 would be the delivery date entered for the purpose of the registration. Please email the B2B 

Service Department to notify us of the delivery date of any item(s) that were not part of the initial delivery so that we can 

properly note the consumers registration.


